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Novo Ambiente de Trabalho 2D
Se usa apenas comandos 2D de AutoCAD® LT, 
porque não usar o novo ambiente de trabalho 
de Projecto 2D & Anotação (2D Drafting & 
Annotation)? Esta função oferece ferramentas 
2D poderosas no Dashboard.

Paletas de Ferramentas
Quando arrasta geometria para uma paleta de 
ferramentas inactiva, esta é automaticamente 
activada para facilitar a inserção – basta 
esperar um segundo extra para mudar.

• Uma nova opção de Especifi car Imagem 
do menu de atalhos torna mais fácil 
atribuir uma imagem a uma ferramenta.

•  Agora, o catálogo de ferramentas 
(e o perfi l) grava a posição das 
ferramentas numa paleta, tornando 
mais fácil partilhar as suas paletas de 
ferramentas com os colegas e manter o 
mesmo aspecto e comportamento.

•  Use TPNAVIGATE para defi nir uma paleta 
de ferramentas como corrente na linha de 
comando.

Interface do Utilizador

Painéis 2D do Dashboard  
Os novos painéis de controlo 2D permitem o 
fácil acesso a layers e incluem controlos para 
escala de anotação, textos, cotas, múltiplos 
leaders, tabelas, comandos de navegação 2D, 
propriedades de objecto e atributos de bloco.

Limpar o Ecrã
Use o botão Limpar Ecrã, no canto inferior 
direito do ecrã para ocultar tudo, com 
excepção da barra de estados, da barra de 
menus e da janela de comandos. Esta fun-
cionalidade é prática sempre que precisar 
de mostrar fi cheiros a um cliente e precisar 
de limpar com rapidez a sua interface.
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Controlar a posição das Barras e Paletas de 
Ferramentas
Insira as suas paletas no lado esquerdo ou 
direito da área de desenho para um acesso 
mais rápido às mesmas. As paletas abrem-se 
ou fecham-se sempre que o cursor se deslocar 
sobre elas, mantendo-as fora de seu caminho. 
Pode facilmente empilhar várias paletas em 
cada lado do ecrã, para uma maior produtivi-
dade. Basta clicar com o botão da direita do 
rato na barra de nome e seleccionar Anchor 
Left ou Anchor Right do menu de atalhos.
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Escala de Anotação

Se achar frustrante e confuso obter o factor 
de escala adequado por viewport, então a 
nova escala de anotação será o ideal para si! 
Deixará de ter de criar diversos grupos de 
textos e cotas em layers diferentes. Agora, só 
precisa de criar um único conjunto de objectos 
de anotação (i.e. texto, cotas, leaders múlti-
plos, blocos, atributos e tramas) e indicar o 
tamanho de impressão real desejado para que 
se apresentem no tamanho correcto, como 
uma magia.

Controlar a Escala de Anotação
Uma nova propriedade de anotação pode 
ser atribuída a objectos como texto, cotas, 
blocos e tramas. Crie simplesmente o objecto, 
no tamanho real em que pretende que o 
mesmo seja impresso e indique os factores 
de escala desejados. A qualquer objecto com 
propriedade de anotação pode ser atribuída 
uma ou várias escalas (i.e. 1⁄4”=1’ ou 1:50). 
Esta funcionalidade facilita a visualização 
do mesmo objecto em várias viewports 
diferentes, com factores de escala distintos. 
Por exemplo, o mesmo objecto de texto pode 
aparecer numa viewport à escala de 1/8” = 1’, e 
noutra viewport à escala de 1”=1’.

Escala de A
notação

Melhorias no separador Layout

• Renomeie um layout fazendo duplo clique 
no separador Layout. 

•  Reordene os layouts com um simples 
arrastar e largar.

•  Use as teclas Ctrl e Shift para seleccionar 
vários layouts para arrastar e largar.

•  Mantenha Ctrl premida enquanto arrasta 
para criar uma cópia.

Pode transformar um objecto já existente 
para anotação com o comando Properties. 

CONSELHO  Converter em anotação um 
estilo ou uma defi nição não afecta os 
objectos existentes. Use o novo comando 
ANNOUPDATE para actualizar os objectos 
seleccionados, em consonância com o seu 
estilo ou defi nição (apenas no espaço de 
modelação).
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Como é que consegue distinguir se um objecto 
é de anotação só olhando para ele? Arraste 
o cursor por cima do objecto para ver o novo 
indicador de anotação.

CONSELHO  Defi na o factor de escala de anota-
ção no espaço de modelação, para refl ectir o 
factor de escala mais usado no desenho. 

Para os objectos que devam ser visualizados 
em vários factores de escala, use a paleta 
Properties para adicionar os factores. Pode 
também usar o comando OBJECTSCALE. 

CONSELHO  Se estiver a trabalhar com tipos 
de objectos diferentes, é mais rápido se usar o 
comando OBJECTSCALE. 
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Novos Controlos de Anotação na Barra 
de Estado

•  Use os dois novos controlos da barra 
de estado para defi nir a Escala de VP e 
Escala de Anotação (acessível apenas se a 
viewport estiver desbloqueada). 

•  Sempre que se selecciona uma viewport 
aparece um novo botão Lock/Unlock 
Viewport.

•  Apenas os objectos de anotação com 
o mesmo factor de escala da viewport 
aparecem numa viewport. Ligue/desligue 
o novo botão Annotation Visibility para 
visualizar os objectos de anotação em todas 
as escalas (mesmo que não sejam suportados 
pela escala de anotação actual da viewport).

CONSELHO  Use SCALELISTEDIT para 
personalizar a lista de escalas.

EXTRA  Para evitar que um objecto de an-
otação desapareça, antes de alterar a Escala 
de Anotação clique no botão Automatically 
Add Scales to Annotative Objects quando 
alterar a Escala de Anotação. 

Escala de A
notação

Compatibilidade com Conversões Anteriores
Uma nova opção no separador Open and 
Save do comando Options ajuda garantir que 
aqueles que não estejam a usar o 
AutoCAD® LT 2008 possam ver os seus objec-
tos de anotação. Cada escala dos objectos é 
guardada como um objecto independente na 
sua própria layer. As layers são automatica-
mente inutilizadas na viewport apropriada.

CONSELHO  Se tiver uma quantidade elevada 
de objectos de anotação, pode acelerar as 
operações, desactivando a opção Maintain 
Visual Fidelity. Não se esqueça de a activar 
novamente, antes de gravar o fi cheiro com 
formato de versões anteriores!

EXTRA  Os tipos de linha adoptam automati-
camente a escala de anotação da viewport. 
Se necessário, desactive este comportamento 
com a variável MSLTSCALE.
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Mais Funcionalidades Úteis de Cotagem:
•  A nova ferramenta Inspection Dimension 

(DIMINSPECT) cria cotas de inspecção. 
• O comando DIMJOGLINE adiciona um jog 

(regulação ponto a ponto) às cotas lineares.
• O comando DIMSPACE atribui espaços de 

forma uniforme às cotas.
• Os comandos actualizados de cota de raio e 

de diâmetro cotam os arcos para além dos 
seus pontos de fi m de linha.

• O comando Angular Dimension actualizado 
permite situar o texto de cotagem fora do 
ângulo a ser medido.

• A nova opção de Tolerance Alignment, na 
caixa de diálogo Dimension Style, 
permite-lhe alinhar os separadores decimais 
e os símbolos de operação.

Comando Inteligente de Corte de Cota
O novo comando DIMBREAK corta as linhas 
de cota ou de referência onde estas se 
intersectam com objectos ou outras cotas. 
Os cortes actualizam-se automaticamente se 
deslocar os objectos de intersecção—mesmo 
que deixem de intersectar! Pode também usar 
a opção Restore para remover todos os cortes.

CONSELHO  Use o menu de atalhos para 
adicionar linhas leaders. Use grips para 
acelerar a edição.

Alinhar as Linhas Leaders
Os leaders estão mal alinhados? A nova 
ferramenta Multiple Leader Align alinha-os 
por si no local pretendido. Pode até controlar 
o espaço entre eles!

Use o comando MLEADERCOLLECT para 
combinar leaders múltiplos do tipo bloco num 
único leader múltiplo. 
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Técnicas de Cotagem
Técnicas de C

otagem

Novos Leaders Múltiplos
O novo comando MLEADER oferece um 
controlo ainda maior sobre os leaders. Para 
além de controlar a ordem de criação dos 
leaders (seta, linha de chamada ou conteúdo), 
também pode adicionar várias linhas leaders 
onde e assim que for necessário.

Novo Gestor de Estilos de Leader Múltiplo
O novo comando MLEADERSTYLE controla as 
opções de formato e visualização, tal como os 
estilos de cotagem. As novas opções são:

• Tipo de linha leaders (recta, spline, ou nenhuma)
• Tipo de seta
• Informação sobre conexão do leader
• Informação sobre o texto
• Atribuir um bloco (ideal para criar referên-

cias numéricas!)
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Economia de tempo

Economia de tempo com texto
Use estes truques úteis para poupar tempo 
sempre que estiver a trabalhar com textos no 
AutoCAD LT® 2008.

Ajuste de Colunas de Mtext
Sempre desejou que o texto se ajustasse au-
tomaticamente nas várias colunas das vastas 
áreas de seu desenho? O seu desejo pode 
agora ser realizado com a nova opção colunas 
dinâmicas do comando MTEXT. Use grips ao 
longo da régua de formatação do texto para 
obter os resultados exactos que tanto deseja. 

Maior Controlo dos Parágrafos
O comando MTEXT actualizado permite um 
maior controlo sobre o alinhamento, e sobre 
os espaçamentos dos parágrafos. 

Maior Efi cácia do Corretor Ortográfi co
Não precisa de seleccionar os objectos 
primeiro. Agora, o corretor ortográfi co 
analisa o desenho inteiro, por predefi nição. 
Se preferir, pode especifi car o espaço actual 
ou os objectos específi cos. Assim que um erro 
é detectado, o AutoCAD LT destaca e faz o 
zoom da palavra no desenho.

A nova caixa de diálogo Check Spelling Settings 
permite-lhe personalizar o corrector ortográ-
fi co. Pode incluir texto de cotagem, atributos 
e xrefs, e defi nir várias exclusões como letras 
maiúsculas ou termos com números.

Criar Atributos com Várias Linhas de Texto 
A nova opção Multiple Lines permite-lhe criar 
atributos que suportam linhas múltiplas, 
sublinhar, sobrelinhar (overlining), campos, etc... 
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Criar uma Tabela a partir de uma Ligação 
de Dados
Uma nova opção do comando TABLE permite-
-lhe também criar uma tabela a partir de um 
fi cheiro Excel. Basta seleccionar parte da folha 
ou a folha inteira. 

Manter as Alterações nas Tabelas
Todas as alterações que introduzir numa 
tabela de AutoCAD LT fi cam guardadas, 
mesmo se actualizar a tabela para refl ectir as 
alterações no fi cheiro Excel!

CONSELHO  Use o comando DATALINK para 
gerir todas as ligações de dados.

Ajustar Tabelas ao Longo de Múltiplas Linhas
Para ajustar uma tabela a várias linhas, basta 
seleccioná-la e ajustá-la com grips ou usar 
as novas ferramentas Table Break na paleta 
Properties.
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Economia de Tempo com Tabelas
As capacidades melhoradas do AutoCAD LT®

2008 poupam-lhe esforços sempre que tiver 
de trabalhar com tabelas.

Tabelas Excel Bidireccionais
Não seria agradável se pudesse inserir uma 
tabela de Microsoft® Excel® num desenho de 
AutoCAD LT e estabelecer uma ligação fi el 
ao fi cheiro, para que quando o fi cheiro Excel 
fosse alterado o mesmo seja actualizado em 
AutoCAD LT, e vice-versa? As boas notícias 
chegaram fi nalmente, porque agora pode fazer 
exactamente isso! 

Basta usar o novo comando Paste Special, 
escolher Entidades de AutoCAD, e seleccio-
nar Paste Link para inserir a folha de cálculo 
Excel no AutoCAD LT. Este processo cria uma 
ligação de dados. Sempre que o fi cheiro XLS 
sofrer modifi cações, um balão de notifi cação 
informa o utilizador de que a informação foi 
alterada e disponibiliza-lhe uma opção simples 
de actualizar a tabela. 

Criar Incremental Data Fast
O novo preenchimento automático permite-
-lhe incrementar com rapidez dados em células, 
arrastando, tal como no Excel. Pode também 
combinar blocos e textos na mesma célula!

Visualizar novas Dicas de Grip em Blocos 
Dinâmicos
À medida que desloca o cursor sobre um grip 
de bloco dinâmico, a descrição do parâmetro 
associado apresenta uma dica de ferramenta.

Recuperar Desenhos Juntamente com Xrefs
Um novo utilitário de desenho permite-lhe 
executar o processo de recuperação de um 
desenho e de todos os xrefs associados. 
Pode encontrar esta funcionalidade em 
Files>Drawing Utilities ou use o comando 
RECOVERALL.

Mudar Copy Multiple Default
Se preferir fazer uma única cópia por defeito, 
defi na a variável do sistema COPYMODE em 1.
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Inutilizar uma Layer em todas as Viewports
O menu de atalhos permite-lhe criar uma 
nova layer que está inutilizada em todas as 
viewports, uma função que está também 
disponível como um novo botão. Aqui, vai 
encontrar também controlos adicionais para 
inutilizar ou reutilizar as layers seleccionadas 
em todas as viewports. 

Renomear Layers
Existem agora três modos para renomear uma 
layer: fazer duplo clique sobre o nome da layer, 
seleccionar a layer e premir F2, ou escolher 
Rename no menu de atalhos.
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Layers

O comando Layer é o terceiro comando mais 
frequentemente usado no AutoCAD LT. 
Estas adições tornam este popular comando 
ainda melhor!

Personalizar o Gestor de Layers
Agora, pode controlar a ordem de visualização 
das colunas de propriedade de layers bastando 
arrastar os títulos das colunas — ordene os 
seus favoritos à esquerda para um acesso 
mais fácil. Demasiadas colunas? Desligue as 
que não está a usar, escolhendo Customize do 
menu de atalhos.

Propriedades de Layer por Viewport
Quantas vezes desejou poder atribuir proprie-
dades de layer por viewport? Desejo realizado! 
Chegou ao fi m a monótona tarefa de duplicar 
geometria em layers separados e de activar e 
desactivar as layers por viewport. Agora, pode 
fazer duplo clique numa viewport e atribuir 
uma cor específi ca, um tipo de linha, uma 
espessura de linha e um estilo de plotagem 
por layer que afecte exclusivamente a essa 
viewport. (Viva!)  

Elimine estas modifi cações de 
viewport no menu de atalho. Use 
VPLAYEROVERRIDESMODE  para ignorar 
provisoriamente as modifi cações, para 
visualizar ou imprimir. Estas modifi cações 
afectam apenas os objectos por bylayer. Use o 
novo comando SETBYLAYER para alterar com 
rapidez objectos em bylayer, incluindo os que 
se encontram dentro de blocos!

Acesso Directo ao Gestor de Estados da Layer
Um novo comando LAYERSTATE (LAS, atalho) 
permite o acesso ao Gestor de Estados de 
Layer a partir da linha de comando (também 
no painel de layer do Dashboard). Use a nova 
opção Import para inserir estados da layer, 
directamente de fi cheiros DWG™, DWT ou 
DWS. Agora, pode também editar ou ver os 
estados de referências externas (xrefs)!
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Nova CUI rápida
O comando QUICKCUI apresenta uma caixa 
de diálogo de Customize User Interface 
simplifi cada para acelerar a personalização. 
Basta arrastar os comandos para as barras ou 
paletas de ferramentas.

Duplo Clique
Quando clicar duas vezes sobre um objecto, 
activa um comando. Agora, pode designar qual 
o comando a ser executado com cada tipo de 
objecto! Por exemplo, se fi zer duplo clique 
sobre a defi nição de um atributo, o comando 
DDEDIT é executado, permitindo-lhe editar 
apenas o valor do atributo.
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Nova Ferramenta de Avaliação de Layer
Um botão novo Settings do comando Layer 
permite ao utilizador activar uma nova 
ferramenta de avaliação de layer. 

• Quando gravar ou imprimir pela 1ª vez, a 
lista de layers actual é guardada para fi ns 
de avaliação.

• Sempre que forem adicionadas novas layers, 
aparece uma notifi cação de Novos Layers 
Não Reconciliados “Unreconciled New 
Layers”. Clique no link para visualizar as 
layers que não coincidem.

• É automaticamente criado um novo fi ltro 
para as layers não reconciliadas.

• O Layer Settings permite personalizar este 
processo.

• Duas novas variáveis do sistema estão agora 
disponíveis: LAYEREVAL e LAYERNOTIFY. 

Novo Painel de Layers do Dashboard
O novo painel de Layer permite o fácil acesso 
a estas ferramentas óptimas, incluindo os 
populares comandos Layer Isolate (LAYISO) e 
Layer Unisolate (LAYUNISO)! As novas opções 
de fading permitem bloquear e escurecer as 
layers de fundo, em vez de as ter de ocultar 
completamente.

Personalizar

Personalizar

Novas Funcionalidades de CUI
Agora, pode personalizar o Dashboard e as 
paletas com todos os seus comandos favoritos 
do comando CUI, arrastando simplesmente 
um comando da lista de comandos, directa-
mente para a paleta. Personalize o Dashboard, 
arrastando os comandos para o novo painel 
Dashboard apresentado na parte superior 
direita da CUI. Pode até criar uma nova linha 
de ferramentas no Dashboard, arrastando uma 
barra de ferramentas do nó de Barra de 
Ferramentas para o nó do Dashboard.

Uma nova ferramenta de pesquisa torna 
mais fácil encontrar os comandos. A macro 
associada a cada comando aparece como uma 
descrição de ferramenta se arrastar o cursor 
sobre o comando. 

Novo Painel de Pré-Visualização Dinâmica
É fácil arrastar ferramentas do Dashboard e as 
barras de ferramentas para o Painel de 
Pré-Visualização da CUI. 
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Trabalhar com fi cheiros DGN
Agora, pode anexar fi cheiros DGN V8 de 
Bentley MicroStation® aos seus desenhos de 
AutoCAD LT ou exportar fi cheiros DWG para 
o formato DGN V8 com a função File>Export. 
Insira-os como fundos (underlays) com 
referências externas com DGNATTACH, com a 
função Insert>DGN Underlay. Delimite o DGN 
com o menu de atalhos (ou use DGNCLIP) e 
use Properties para ajustar o contraste, fade e 
monocromo (ou DGNADJUST). 

Importe dados DGN V8 com DGNIMPORT, usan-
do File>Import. Durante a importação, uma caixa 
de diálogo pede informação sobre as referências 
externas de DGN, nós de textos e unidades para 
ajudar a conseguir melhores resultados.

É importante partilhar a informação do seu 
desenho e o AutoCAD LT® 2008 torna ainda 
mais fácil esta tarefa.

Usar Ficheiros DWF como Fundos (Underlays)
O comando DWFATTACH permite-lhe usar um 
fi cheiro DWF™ como um fundo, tal como com 
as imagens raster. O fi cheiro DWF está ligado, 
mas sem estar fi sicamente incluído no fi cheiro 
de desenho, o que permite manter pequeno 
o seu tamanho. Pode ajustar para um fi cheiro 
DWF anexo e regular propriedades como fade, 
contraste e monocromo a partir da paleta de 
Properties ou com o comando DWFADJUST. 
Use o menu de atalho para delimitar o fi cheiro 
DWF e controlar a visibilidade de layers de um 
fi cheiro DWF seleccionado.
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Referências Externas
Agora, pode usar o comando XREF para ver 
todos os fi cheiros referenciados externamente 
numa única localização central. Aqui, encon-
trará todos os fi cheiros de desenho, DWF, 
imagens e DGN anexos.

Plotar para PDF
Use o assistente Add Plotter para imprimir os 
seus desenhos no formato PDF. Em Manufac-
turers, seleccione Autodesk ePlot (PDF) e em 
Models, seleccione PDF.

Acesso a fi cheiros DWG
O AutoCAD LT® 2008 permite-lhe abrir fi chei-
ros DWG de versões anteriores, até AutoCAD 
versão 2.0 e AutoCAD LT versão 1.0 (antigo!). 

• Conversão bidireccional de fi cheiros DWG, 
entre AutoCAD LT 97 e AutoCAD LT® 2008, 
com as funções de conversão do software 
DWG TrueView™ 2008.

• Agora, todos podem ver, publicar e plotar 
fi cheiros DWG com DWG TrueView. 

Faça o download gratuito do DWG TrueView 
(e o gratuito é do agrado de toda a gente!) em 
www.autodesk.com/dwg.

CONSELHO  Use o DWG TrueView para aplicar 
uma confi guração de página para múltiplos 
espaços de composição!
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